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About this guide  
This guide is designed to provide a quick introduction to PROMODAG Reports for Microsoft 
Exchange Server, and it describes steps from getting started to producing the first report.  

For more details about specific features of PROMODAG Reports, please refer to the online Help 
system.  

  

Introducing PROMODAG Reports  

PROMODAG Reports is an advanced and cost-effective reporting tool that enables Exchange 
Server administrators and IT managers to obtain valuable information about all aspects of their 
email system. 

With its powerful and easy-to-understand features, PROMODAG Reports produces 
comprehensive reports that you can rely on to ensure better security, business continuity, and to 
improve Exchange organization performance. 

PROMODAG Reports is easy to install and configure. Reports use native Exchange server data 
sources; so there is nothing to install on the server. The product collects and stores the 
necessary data into an Access or SQL Server database. You can choose from over 80 ready-
made reports and publish them to various destinations in different formats. All operations can be 
easily automated and scheduled so you can set up the product and forget about it.  



  Getting started with PROMODAG Reports  5 

How does it work? Reports data sources 

PROMODAG Reports retrieves the information it needs to produce its various reports from 
different native Exchange data sources. 

•  Reports on flow and traffic are based on Exchange message tracking files previously 
imported into the database.  

• Reports on OWA and ActiveSync activity are based on Internet Information Services 
logs previously imported into the database. 

• Reports on Exchange-related directory objects are likewise based on the information 
retrieved during directory import.  

• On the other hand, reports on storage, on content or on size directly take their 
information from Exchange through a dynamic MAPI connection.  

 

What data 
sources? 

What for? 

Message 
tracking 

The message tracking data source is used to produce 
various reports on email traffic. PROMODAG Reports 
uses message tracking files to record all mail activity. 
Each message received or sent from or to the server 
generates an event in the daily message tracking file. 
PROMODAG Reports reads these files, analyzes their 
content and stores the result into the  database. 

Directory 
The directory data source is used to produce reports on 
Exchange-related directory objects. The application 
needs to retrieve all Exchange-related objects from the 
directory to identify recipients. For instance, this 
information is used to list and group mailboxes attributes 
(department, country...). PROMODAG Reports connects 
to the directory via a Global Catalog server, and then 
stores the recipients it discovered into the database. 

Internet 
Information 
Services 

The IIS data source is used to produce reports on OWA 
(Outlook Web Access) and ActiveSync activity. 
PROMODAG reports reads the Internet Information 
Services log files, then store the information into the 
database.  

Note: This feature is not available with Microsoft 
Exchange version 2000, 5.x and 4.0. 

Mailbox and 
Public folder size The Mailbox and Public folder size data source is used to 

produce reports on mailbox and public folder size. 
Information is based on a 'snapshot' taken at the time 
when the import is run. It is dynamically collected either 
through a MAPI connection to the Exchange server (all 
supported versions of Exchange Server until 2007), or 
Remote Powershell (Exchange 2010 only). PROMODAG 
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What data 
sources? 

What for? 

Reports imports the size of default public folders (IPM) 
as well as the size of system public folders (non-IPM). 
Data is stored into the database in some cases, or 
dynamically retrieved and therefore not recorded. 

Mailbox and 
Public folder 
content 

The Mailbox and Public folder content data source is 
used to produce reports on mailbox and public folder 
content. Information is based on a 'snapshot' taken at the 
time when the report is run. It is dynamically collected 
through a MAPI connection to the Exchange server. Data 
is not stored into the database. 

Information store 
size  This data source is used to produce reports on storage 

size. Information Store size import is based on a 
'snapshot' taken at the time when the import is run. It 
records the size of the EDB and STM files found on the 
Exchange server. Data is stored into the database. 

Internet Mail 
Service archival The IMC data source contains all messages that have 

gone through the Internet Mail Connector. The archives 
give the subject of messages received from or sent to the 
Internet. PROMODAG reports reads the IMC log files, 
then store the information into the database.  

Note: This feature is only available with Microsoft 
Exchange version 4.0, 5.x. 



  

  

Chapter 1 - Setting up your environment 

A - Microsoft Exchange Server requirements 
Supported versions (32 or 64-bit) of Microsoft Exchange Server are: 

• 2010 
• 2007 
• 2003 
• 5.5 
• 5.0 
• 4.0 

Note: It is possible to use the product with a mix of different Exchange Server versions.  

You do not need to install anything on the Exchange Server, or to modify anything in your 
Exchange organization. 

B - Workstation requirements 

1. Workstation hardware and software requirements  
 

Item Requirement 

Processor A 2 GHz Intel Pentium Processor. 

System memory 1 GB of system memory. 

Disk space Sufficient disk space to store the database. 

Supported operating systems One of the following operating systems (32 or 64-bit):  
• Windows Server 2008 R2  
• Windows 7  
• Windows Server 2008  
• Windows Vista SP2 
• Windows Server 2003 SP2  
• Windows XP SP3. 

Software framework Microsoft .NET Framework 3.5 SP1. 

Messaging API (MAPI) client 
libraries 

Messaging API (MAPI) client libraries included with: 
• Microsoft Exchange Server MAPI client and CDO 1.2.1 version 

6.5.8146.0 or higher 
• Outlook 2010 (32-bit version only) 
• Outlook 2007  
• Outlook 2003 
• Outlook XP (2002) SP1. 

Remote Powershell  Windows Management Framework Core package. 
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2. SQL Server requirements for PROMODAG Reports Enterprise edition 
 

Item Requirement 

Database 
management 
system  

One of the following Microsoft SQL Server version (32 or 64-bit): 
• Microsoft SQL Server 2008 R2 
• Microsoft SQL Server 2008 
• Microsoft SQL Server 2005. 

Note: SQL Server Express (2008 R2, 2008, 2005) may be used with PROMODAG 
Reports Enterprise edition; however, database size is limited depending on the 
version (10 GB for SQL Server 2008 R2 Express and 4 GB for SQL Server 
2005/2008 Express ).  

C - PROMODAG account permissions 
 

Item Permission requirements 

Local computer The PROMODAG account must be a member of the local 
Administrators group.  

Exchange server directories The PROMODAG account must have been granted, at least, 
Read-Only permissions on the following items: 

• Exchange message tracking file directories (Exchange 
2007/2010, Exchange 2000/2003); 

• Internet Information Services file directories (IIS 7.0, IIS 
6.0); 

• Exchange database files (Exchange 2007/2010, 
Exchange 2000/2003). 
  

Exchange Organization The PROMODAG account must have been granted, at least, the 
following roles on the Exchange organization: 

• Exchange 2010: Organization Management; 
• Exchange 2000/2003 and 2007: Exchange View-Only 

Administrator. 
PROMODAG Reportsrequires those permissions to access the 
Directory, and to run PowerShell commands. See also:  

"Configuring directory import in Exchange 2007/2010", on page 
9. 

"Configuring directory import in Exchange 2000/2003", on page 
12. 

SQL Server permissions (PROMODAG 
Reports Enterprise edition only) 

The PROMODAG account must have been granted the following roles: 
• dbo on the PROMODAG Reports database. 
• public and db_datareader on the TEMPDB database. 



  

  

D - Exchange Server 2007/2010 

1. Configuring the directory data source  

Introduction 
The directory data source is used to produce reports on Exchange-related directory objects. The 
application needs to retrieve all Exchange-related objects from the directory to identify recipients. For 
instance, this information is used to list and group mailboxes attributes (department, country...). 
PROMODAG Reports connects to the directory via a Global Catalog server, and then stores the 
recipients it discovered into the database. 

Configuring directory import in Exchange 2007/2010 
You must use an account that has at least the View-Only Organization Management  role (Exchange 
2010)or Exchange View Only Administrator role (Exchange 2007) on the Exchange organization in order 
to be able to import the directory. 

2. Configuring the message tracking data source  

Introduction 
The message tracking data source is used to produce various reports on email traffic. PROMODAG 
Reports uses message tracking files to record all mail activity. Each message received or sent from or to 
the server generates an event in the daily message tracking file. PROMODAG Reports reads these files, 
analyzes their content and stores the result into the  database. 

Message tracking files and Exchange 2007/2010 server roles 
Only servers that have been granted a transport role (Hub Transport and Edge Transport) generate 
message tracking files that can be used by PROMODAG Reports to produce reports on traffic. Therefore, 
message tracking files of mailbox servers without transport roles are not imported. 

The name format for message tracking files generated by those server roles are: 

• MSGTRKyyyymmdd-1.LOG for Hub Transport or Edge Transport servers.  
• MSGTRKMyyyymmdd-1.LOG (NB: the name contains an additional M) for Mailbox servers. 

Message tracking files location  
By default, the Exchange server generates message tracking files in  

• Exchange 2010: C:\\Program Files\Microsoft\Exchange 
Server\V14\TransportRoles\Logs\MessageTracking, 

• Exchange 2007: C:\Program Files\Microsoft\Exchange 
Server\TransportRoles\Logs\MessageTracking. 

Those directories are not shared by default and PROMODAG Reports uses the following UNC paths to 
access them: 

• Exchange 2010: \\<Server>\C$Program Files\Microsoft\Exchange 
Server\V14\TransportRoles\Logs\MessageTracking, 

• Exchange 2007: \\<Server>\C$\Program Files\Microsoft\Exchange 
Server\TransportRoles\Logs\MessageTracking. 

Those paths reference the C$ shared resource that can only be accessed with administrative rights. 
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Therefore, you can either use an administrative account to run PROMODAG Reports, or enter an 
administrative account name and password in Server Properties, Security tab. 

If you cannot or if you do not wish to use an administrative share, please see the Online help to set up a 
shared resource and configure its path in PROMODAG Reports, or copy message tracking files into 
another folder (on a local or network share) and configure its path in PROMODAG Reports. 

Note: Please make sure that you grant the required permissions if you decide to change the location of 
the message tracking files directory. For more information, please refer to Microsoft Technet. 

Rights and permissions 
The user account used to start PROMODAG Reports (or the administrative account defined in Server 
Properties, Security tab) must have at least Read-Only access permissions to the message tracking files 
shared folder. This folder is not shared by default. 

Enabling message tracking 

By default, message tracking is enabled on all Exchange 2007/2010 computers that have the Hub 
Transport, Mailbox, or Edge Transport server roles installed.  

Note: Enabling or disabling message tracking in Exchange Management Console is only available from 
Exchange 2007 SP1 onwards. 

How long should message tracking files be kept? 

By default, Microsoft Exchange Server keeps message tracking files for a duration of 30 days. This 
default setting can be changed in the 'Log file maintenance' parameters. 

For more information on how to enable message tracking in Exchange 2007/2010, see the Microsoft 
Technet website. 

3. Configuring the Mailbox and Public folder content data source  

Introduction 
The Mailbox and Public folder content data source is used to produce reports on mailbox and public 
folder content. Information is based on a 'snapshot' taken at the time when the report is run. It is 
dynamically collected through a MAPI connection to the Exchange server. Data is not stored into the 
database. 

Rights and permissions 
You must be logged in with an account that has at least the Exchange View Only Administrator role 
(Exchange 2007) or View-Only Organization Management role (Exchange 2010) on the Exchange 
organization in order to be able to access the content of mailboxes and public folders. 

Enabling such permissions requires a Microsoft Exchange Server administrator role.  

Exchange 2010: 

Add the user account into the relevant role group using Active Directory Users and Computers tool 
(ADUC). You will find this group in the Microsoft Exchange Security Group Organizational Unit. 

Exchange 2007: 

• Start the Exchange Management Console tool. 
• Right-click Organization Configuration and select the Add Exchange Administrator option. 

http://technet.microsoft.com/en-us/library/aa997984.aspx
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• Select the user account used to start PROMODAG Reports (or the account defined in theServer 
Properties, Security tab option of PROMODAG Reports) and set its role to Exchange View-Only 
Administrator . 

4. Configuring the Mailbox and Public folder size data source  

Introduction 
The Mailbox and Public folder size data source is used to produce reports on mailbox and public folder 
size. Information is based on a 'snapshot' taken at the time when the import is run. It is dynamically 
collected either through a MAPI connection to the Exchange server (all supported versions of Exchange 
Server until 2007), or Remote Powershell (Exchange 2010 only). PROMODAG Reports imports the size 
of default public folders (IPM) as well as the size of system public folders (non-IPM). Data is stored into 
the database in some cases, or dynamically retrieved and therefore not recorded. 

Rights and permissions 
You must use an account that has at least  

• The Organization Management role (Exchange 2010) - it should be able to run PowerShell 
commands - or 

• The Exchange View Only Administrator role (Exchange 2007) 

on the Exchange organization to import the size of mailboxes and public folders. 

Enabling such permissions requires a Microsoft Exchange Server administrator role.  

Exchange 2010: 

Add the user account into the relevant role group using Active Directory Users and Computers tool 
(ADUC). You will find this group in the Microsoft Exchange Security Group Organizational Unit. 

Exchange 2007: 

• Start the Exchange Management Console tool. 
• Right-click Organization Configuration and select the Add Exchange Administrator option. 
• Select the user account used to start PROMODAG Reports (or the account defined in theServer 

Properties, Security tab option of PROMODAG Reports) and set its role to Exchange View-Only 
Administrator . 

5. Configuring the Information store size data source  

Introduction 
This data source is used to produce reports on storage size. Information Store size import is based on a 
'snapshot' taken at the time when the import is run. It records the size of the EDB and STM files found on 
the Exchange server. Data is stored into the database. 

Databases location 

Exchange 2007 

The default paths to mailbox and public folder databases when you install Exchange 2007 are: 

• C:\Program Files\Microsoft\Exchange Server\Mailbox\First Storage Group\Mailbox database.edb 
(for mailboxes) 

• C:\Program Files\Microsoft\Exchange Server\Mailbox\First Storage Group\Public Folder 
database.edb  (for public folders). 

Exchange 2010 
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The default paths to mailbox and public folder databases when you install Exchange 2010 are: 

• C:\Program Files\Microsoft\Exchange Server\V14\Mailbox\<Mailbox database name>\<Mailbox 
database name.edb (for mailboxes) 

• C:\Program Files\Microsoft\Exchange Server\V14\Mailbox\<Public folder database name>\<Public 
folder database name>.edb (for public folders). 

These default paths can be changed in the Storage Size tab of the Server Properties dialog box of 
PROMODAG Reports. Exchange 2007 and 2010 do not use STM files. 

Rights and permissions 
The user account used to start PROMODAG Reports (or the administrative account defined in Server 
Properties, Security tab) must have at least Read-Only access permissions to the files containing 
Exchange Information Stores (EDB files). 

  

E - Exchange Server 2000/2003 

1. Configuring the directory data source  

Introduction 
The directory data source is used to produce reports on Exchange-related directory objects. The 
application needs to retrieve all Exchange-related objects from the directory to identify recipients. For 
instance, this information is used to list and group mailboxes attributes (department, country...). 
PROMODAG Reports connects to the directory via a Global Catalog server, and then stores the 
recipients it discovered into the database. 

Configuring directory import in Exchange 2000/2003 
You must be logged in with an account that has at least the Exchange View Only Administrator role on 
the Exchange organization in order to be able to import the directory. 

Enabling such permission requires a Microsoft Exchange Server administrator role and can be setup with 
the Exchange System Manager tool. 

• Start Exchange System Manager. 
• Right-click the Exchange organization name. 
• Choose Delegate control. 
• Select the user account used to start PROMODAG Reports (or the account defined in theServer 

Properties, Security tab option of PROMODAG Reports) and set its role to Exchange View-Only 
Administrator. 

2. Configuring the message tracking data source  

Introduction  
The message tracking data source is used to produce various reports on email traffic. PROMODAG 
Reports uses message tracking files to record all mail activity. Each message received or sent from or to 
the server generates an event in the daily message tracking file. PROMODAG Reports reads these files, 
analyzes their content and stores the result into the  database. 
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Message tracking files location 
By default, PROMODAG Reports looks for message tracking files in the shared resource \\<server 
name>\server_name.log\, that points to the C:\Program Files\Exchsrvr\<server_name>. log folder of 
the Exchange 2000/2003 server. 

This default path can be changed in the Message Tracking tab of the Server Properties dialog box of 
PROMODAG Reports. 

Rights and permissions 
The user account used to start PROMODAG Reports (or the administrative account defined in Server 
Properties, Security tab) must have at least Read-Only access permissions to the message tracking files 
shared folder. 

Note: It is also possible to copy message tracking files on a local or a network share, and import them 
from there. 

Enabling message tracking 

If message tracking is not enabled at the server level on the Exchange server, PROMODAG Reports will 
not work.  

 Enabling message tracking in the Microsoft Exchange Server requires a Microsoft Exchange Server 
administrator role and can be setup using Exchange System Manager tool. 

To enable message tracking, right-click the Exchange 2000/2003 server and click Properties. You can 
also choose Properties from the Action menu.  

On the General tab, select the Enable subject logging and display and Enable message tracking check 
boxes.  

How long should message tracking files be kept? 

By default, Microsoft Exchange Server keeps message tracking files for a duration of 7 days. This default 
setting can be changed in the Log file maintenance parameters to accommodate different needs.  

3. Configuring the Mailbox and Public folder content data source  

Introduction 
The Mailbox and Public folder content data source is used to produce reports on mailbox and public 
folder content. Information is based on a 'snapshot' taken at the time when the report is run. It is 
dynamically collected through a MAPI connection to the Exchange server. Data is not stored into the 
database. 

Rights and permissions 
You must be logged in with an account that has at least the Exchange View-Only Administrator role on 
the Exchange organization in order to be able to access the content of mailboxes and public folders. 

Enabling such permission requires a Microsoft Exchange Server administrator role and can be setup with 
the Exchange System Manager tool.  

• Start Exchange System Manager. 
• Right-click the Exchange organization name. 
• Choose Delegate control. 
• Select the user account used to start PROMODAG Reports (or the account defined in theServer 

Properties, Security tab option of PROMODAG Reports) and set its role to Exchange View-Only 
Administrator. 
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4. Configuring the Mailbox and Public folder size data source  

Introduction 
The Mailbox and Public folder size data source is used to produce reports on mailbox and public folder 
size. Information is based on a 'snapshot' taken at the time when the import is run. It is dynamically 
collected either through a MAPI connection to the Exchange server (all supported versions of Exchange 
Server until 2007), or Remote Powershell (Exchange 2010 only). PROMODAG Reports imports the size 
of default public folders (IPM) as well as the size of system public folders (non-IPM). Data is stored into 
the database in some cases, or dynamically retrieved and therefore not recorded. 

Rights and permissions 
The user account used to start PROMODAG Reports (or the administrative account defined in Server 
Properties, Security tab) must have been granted, at least, the Exchange View Only Administrator role on 
the Exchange organization in order to be able to import the size of mailboxes and public folders. 

Enabling such permission requires a Microsoft Exchange Server administrator role and can be setup with 
the Exchange System Manager tool.  

• Start Exchange System Manager. 
• Right-click the Exchange organization name. 
• Choose Delegate control. 
• Select the user account used to start PROMODAG Reports (or the account defined in theServer 

Properties, Security tab option of PROMODAG Reports) and set its role to Exchange View-Only 
Administrator. 

5. Configuring the Information store size data source  

Introduction 
This data source is used to produce reports on storage size. Information Store size import is based on a 
'snapshot' taken at the time when the import is run. It records the size of the EDB and STM files found on 
the Exchange server. Data is stored into the database. 

 Databases location 
The default paths to mailbox and public folder databases when you install Exchange 2000, 2003 are: 

• C:\Program Files\Exchsrvr\mdbdata\priv1.edb and C:\Program Files\Exchsrvr\mdbdata\priv1.stm 
(for mailboxes).  

• C:\Program Files\Exchsrvr\mdbdata\pub1.edb and C:\Program Files\Exchsrvr\mdbdata\pub1.stm 
(for public folders). 

These default paths can be modified in the Storage Size tab of the Server Properties dialog box of 
PROMODAG Reports. 

Rights and permissions 
The user account used to start PROMODAG Reports (or the administrative account defined in Server 
Properties, Security tab) must have at least Read-Only access permissions to the files containing 
Exchange Information Stores (EDB and STM files). 



  

  

F - Internet Information Services (IIS) 7.0 and 6.0 

1. Configuring the Internet Information Services data source in IIS 7.0 

Introduction 
The IIS data source is used to produce reports on OWA (Outlook Web Access) and ActiveSync activity. 
PROMODAG reports reads the Internet Information Services log files, then store the information into the 
database.  

Note: This feature is not available with Microsoft Exchange version 2000, 5.x and 4.0. 

IIS 7.0 logs location 
By default, IIS 7.0 generates logs in the %SystemDrive%\inetpub\logs\LogFiles directory. 

This folder is not shared by default and PROMODAG Reports uses the following UNC path to access it: 
\\<Server>\C$\inetpub\logs\LogFiles\. This path references the C$ shared resource that can only be 
accessed with administrative rights. 

Therefore, you can either use an administrative account to run PROMODAG Reports, or enter an 
administrative account name and password in Server Properties, Security tab. 

If you cannot or if you do not wish to use an administrative share, please see the Online help to set up a 
shared resource and configure its path in PROMODAG Reports, or copy message tracking files into a 
local folder and configure its path in PROMODAG Reports. 

Rights and permissions 
The user account used to start PROMODAG Reports (or the administrative account defined in Server 
Properties, Security tab) must have at least Read-Only access permissions to the Internet Information 
Services files shared folder. 

Enabling logging in IIS 7.0 
• Start the Internet Information Services Management UI. 
• Expand the server name, right-click Default Web Site for each OWA site, and select Properties. 

In the Default Web Site Home page,  

• Double-click the Logging icon. 

In the Logging page,  

• Verify that the Schedule radio button is selected and that the option is set to Daily. 
• Verify that the log file format selected is W3C and click the Select Fields button. 

In the W3C Logging Fields page, confirm that at least the following logging options are selected: 

• Date (date) 
• Time (time) 
• Client IP address (c-ip) 
• User Name (cs-username) 
• Method (cs-method) 
• URI Stem (cs-uri-stem) 
• URI Query (cs-uri-query). 
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2. Configuring the Internet Information Services data source in IIS 6.0 

IIS 6.0 logs location 
By default, IIS 6.0 generates logs in the %SystemDrive%\WINDOWS\system32\LogFiles\W3SVC1 
directory. 

This folder is not shared by default and PROMODAG Reports uses the following UNC path to access it: 
\\<Server>\C$\WINDOWS\system32\LogFiles\W3SVC1\. This path references the C$ shared resource 
that can only be accessed with administrative rights. 

Therefore, you can either use an administrative account to run PROMODAG Reports, or enter an 
administrative account name and password in Server Properties, Security tab. 

If you cannot or if you do not wish to use an administrative share, please see the Online help to set up a 
shared resource and configure its path in PROMODAG Reports, or copy IIS logs into a local folder and 
configure its path in PROMODAG Reports. 

Rights and permissions 
The user account used to start PROMODAG Reports (or the administrative account defined in Server 
Properties, Security tab) must have at least Read-Only access permissions to the Internet Information 
Services files shared folder. 

Enabling logging in IIS 6.0 
• Start the Internet Information Services (IIS) snap-in. 
• Expand the server name, right-click Default Web Site for each OWA site, and then select 

Properties. 

Under the Web Site tab, verify that the Enable logging checkbox is ticked, then click the Properties button 
to access the Extended Logging Properties dialog box. 

Under the General Properties tab, verify that the New Log Time Period schedule is set to Daily and click 
the Extended Properties tab. 

In the Extended Properties tab, confirm that at least the following logging options are selected: 

• Date (date) 
• Time (time) 
• Client IP address (c-ip) 
• User Name (cs-username) 
• Method (cs-method) 
• URI Stem (cs-uri-stem) 
• URI Query (cs-uri-query). 



  

  

Chapter 2 - Getting started 

A - Evaluating PROMODAG Reports 
You may evaluate PROMODAG Reports for a period of up to 45 days from first installation. The only 
other limitation is that your reports on e-mail traffic or OWA and Active Sync activity can only cover a 
maximal period of 15 days. 

You can indeed only import up to 15 days of Exchange message tracking files or IIS log files in evaluation 
mode, which explains the latter restriction (for more explanations, see: How does it work? Reports data 
sources). 

Note: If you select a reporting period out of these bounds, you will obtain a 'No data match the selected 
period' warning message. This behavior is normal and expected. 

There are no limitation to  

• The number of Exchange servers you can report on, 
• The number of reports you can use - all options being available, or 
• The number of databases you can create 

during your 45-day evaluation period. 

B - Installing PROMODAG Reports  

Note: Please make sure that your workstation complies with all points listed in "Workstation 
requirements", on page 7. before proceeding with the installation process. 

1. Installing PROMODAG Reports  
a. Go to http://www.promodag.com to download PROMODAG Reports. 
b. Choose a temporary directory to store the installation package. 
c. Click on the prpx8e.exe icon from your temporary directory to start the installation process. 
d. Simply follow the instructions of the Installation Wizard. 

2. Uninstalling PROMODAG Reports 
Use the Programs and Features tool (or Add/Remove Programs) tool of the Windows Control Panel to 
remove PROMODAG Reports from your computer. 

The installation folder is located, by default, in %PROGRAMFILES%\Promodag\Reports8. Its content is 
removed when the software is uninstalled. The application parameters, on the other hand, are recorded in 
other directories that are not removed when PROMODAG Reports is uninstalled or upgraded.  

To read more about default paths for installation and settings, see the help file. 

http://www.promodag.com/


  

  

C - Upgrading from a previous version 
To read more about the upgrade process, see the help file. 

D - Initial setup 

1. Selecting the right database format 

What is that database for? 
PROMODAG Reports creates a Microsoft Access or SQL Server relational database using Microsoft 
Exchange Server data sources (directory, message tracking files and Internet Information Services logs). 
The application stores the information it needs to build reports in this database. You may create as many 
databases as you wish.  

What database formats are available? 
The PROMODAG Reports database has a specific structure and supports two different formats. 

Microsoft Access database 

• The physical size limit of a Microsoft Access database is 2 GB. 
• Database file must be located on the same machine as PROMODAG Reports. 
• No multi-user access. 
• No additional cost.  
• Best suited for small Exchange organization. 

Microsoft SQL Server database 

• Database size is only limited by disk space on the SQL Server.  
• Multi-user Access. 
• Performance is determined by the power of the SQL server. 
• An additional SQL Server license (not provided) is required. 
• Requires the Enterprise edition of PROMODAG Reports. 
• Best suited for medium or large Exchange organization. 

Note: SQL Server Express (2008 R2, 2008, 2005) may be used with PROMODAG Reports Enterprise 
edition; however, database size is limited depending on the version (10 GB for SQL Server 2008 R2 
Express and 4 GB for SQL Server 2005/2008 Express ).  

2. Starting PROMODAG Reports 
From the Start Menu, select Programs > Promodag > PROMODAG Reports 8. The configuration wizard 
provides an user-friendly interface to start with PROMODAG Reports. It automatically appears when the 
database is empty, and guides you through the first configuration of the product. 

It provides you with instructions on: 

1. Creating a new PROMODAG Reports database, 
2. Establishing a connection to the directory, 
3. Establishing a connection to the Exchange system, 
4. Selecting data sources to import depending on the reports you need: 

a. Message tracking files,  
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b. Storage size: 
• Mailbox size,  
• Information Store size,  
• Mailbox count per Information Store,  
• Public folder size, 

c. Internet Information Services log files, 
5. Selecting presentation options, 
6. Selecting reports to run at the end of the wizard (optional), 
7. Scheduling and automating import tasks (optional), 
8. Starting the data import process. 

3. Creating a new PROMODAG Reports database  

Selecting a database format   
Choose the type of database you wish to use. For more information about available formats, see 
"Selecting the right database format", on page 18..  

Creating an Access database 

Specify a name for the new Access database (MDB file) as well as a description (optional). 

 

Creating a SQL Server database 

Enter the name of SQL server and specify the name of the new SQL database. You may also add a 
description (optional). You must provide a login name and a password to use SQL Server authentication. 

For more information on using PROMODAG Reports and Microsoft SQL server, please refer to the Online 
help. 
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Click the Finish button to validate these settings. 

The database has now been created and is ready to be populated with data. 
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4. Configuring connections  

Connecting to the directory 
Once you have created your empty database, the first step of the Wizard consists in attempting to find, 
and establish a connection to, a Global Catalog server.PROMODAG Reports needs to connect to the 
directory using LDAP to retrieve the structure of your Exchange organization, and all Exchange-related 
objects. Click the Next button to validate your settings. 

 

  

 

Option Description 

 
Click this button to retrieve automatically the name of a Global Catalog 
server. 

Global Catalog server Enter the name of the Global Catalog server. It will be used to import the 
directory. 

 
Click this button to test the LDAP connection with the Global Catalog 
server. 

 
This green tick appears if the LDAP connection was successfully 
established during the test. 

Current account Check this radio button if the account you used to log in has sufficient 
permissions to access the directory. 

Specific account Check this radio button to specify an administrative account with 
necessary permissions to access the directory. 

Setting up a valid connection to the Exchange system 
PROMODAG Reports needs to establish a connection to the Exchange system to produce reports on 
mailbox or public folder content. You must at least fill the Mailbox and Exchange Server fields. Click the 
Next button to validate these settings. 
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Option Description 

Current account Check the Current account radio button if the account you used to 
login has sufficient permissions to access Exchange.   

Specific account Check the Specific account radio button to specify an administrative 
account with sufficient permissions to access Exchange. 

 
Click this button to verify that the account you used to login has 
sufficient permissions to access Exchange server. A green tick appears 
if this is the case. 

 Click this button to automatically retrieve the mailbox associated to the 
current/specific account. It will be used to establish a MAPI connection 
to Exchange, to send trace files on warnings and errors (see Trace & 
Alert tab), and to email reports. Note: It is strongly recommended to 
create a specific mailbox dedicated to this purpose. 

User name Display name of the mailbox. You may enter a name in that field and 
click the Check name button to search a specific mailbox in the 
directory. 

 
Click this button to manually retrieve a mailbox from the directory. A 
green tick appears to indicate that the search was successful. 

 
Click this button to test the MAPI connection with the Exchange server. 
This verification will also resolve the Legacy Exchange DN of the 
mailbox. A green tick appears if a connection was successfully 
established during the test. 

Exchange Server  Name of the Exchange server hosting the mailbox. 

Mailbox Mailbox Legacy Exchange Distinguished Name of the mailbox 
(/o=OrganizationName/ou=AdministrativeGroupName/cn=ContainerNa
me/cn=MailboxAlias). 
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Applying a license to the database 
The next step allows you either to apply a license file to your database, or to use PROMODAG Reports in 
evaluation mode. 

Select the license file you have received from PROMODAG, and make sure that the edition mentioned as 
well as the number of servers the license covers are correct.  

Note: To use PROMODAG Reports in evaluation mode, select the edition you wish to evaluate and click 
the Resume Evaluation button.  

5. Selecting the right data sources to import 
Select the type of data to import into the database according to the type of reports you wish to produce 
afterwards. Additional information will be requested in the following steps depending on choices made 
here. 

Note: These import options can be modified later. For instance, you may decide not to import data 
related to connector flow to keep your database small. 

  

 

Data sources for traffic reports 
 

Option Description 
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Option Description 

User traffic Select this check box to be able to generate reports on mailbox 
traffic. This is the most common data source. 

Replication traffic Select this check box to be able to generate reports on directory 
and public folders replication traffic. 

Connector flow Select this check box to be able to generate reports on connector 
flow.  

Note: Reports on connector flow are not available in the Standard 
edition.  

Non Delivery Reports (Exchange 
2000, 2003 only) 

Select this check box to be able to generate reports on non-delivery 
reports (NDR).  

Intelligent Message Filter (IMF) 
(Exchange 2003 only) 

Select this check box to be able to generate reports on Intelligent 
Message Filter (IMF).  

Data sources for storage size reports 
 

Option Description 

Mailbox size Import the size and number of items contained in mailboxes located on the 
selected servers. 

Information store size Import the size of the EDB or STM files contained in information stores 
located on the selected servers. 

Mailbox count per 
Information Store 

Import the number of mailboxes located on the selected servers through an 
LDAP connection to the directory. 

Public folder size Import the size and number of items contained on public folders located on 
the selected servers. 

Data sources for OWA and ActiveSync reports 
 

Option Description 

Internet Information Services files (Exchange 
2010, 2007 and 2003 only) 

Select this check box if you need to generate reports on 
Outlook Web Access and ActiveSync.  

Once this step is completed, each selected data source category can be individually configured.   

Configuring the data source for traffic reports   

Highlight the server name to specify from which server(s) data must be imported, and click the  
button to move it to the right pane (you can also double-click the server name). Message tracking files will 
then be imported from all servers listed in the Selected server(s) pane. 

Select Hub and Edge Transport servers (Exchange 2007/2010) or mailbox servers ( Exchange 2000/2003 
or Exchange 4.0/5.x) or to generate reports on traffic. This selection can be modified later.  

Specify the period you wish to import: 
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• From: Date of the first message tracking file to import. 
• To: Date of the last message tracking file to import. The most recent date available is yesterday. 

The location of message tracking files is tested on each selected server when you click the Next button. If 
a location is not valid, a message box appears to allow you to indicate the right location. 

 

Configuring the data source for storage size reports 
Select Exchange servers that will be analyzed to generate storage size reports. 

The location of information stores is tested on each selected server when you click the Next button. If a 
location is not valid, a message box appears to allow you to indicate the right location. 
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Configuring the data source for OWA and ActiveSync reports 
Select Exchange servers that will be analyzed to generate reports on OWA and ActiveSync activity.   

The location of IIS log files is tested on each selected server when you click the Nextbutton. If a location 
is not valid, a message box appears to allow you to indicate the right location. 

 

6. Finalizing the configuration 

Configuring general report options 
Select the following options from the drop-down lists: 

• The language for your reports (choices available are: English, French, German, Spanish, Italian, 
Portuguese, Dutch) 

• The server name prefix in reports according to Exchange organization layouts (Active Directory 
site, routing group or administrative group). 

Click the Next button. 
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The next step is optional. It consists in selecting one or more predefined reports (or report options files) to 
run at the end of the configuration wizard. 

Selecting reports to run at the end of the wizard 
Use this dialog box to select the reports you would like to run automatically once the import process is 
completed. If this is the first time you use the product, you will get a list of predefined reports (or favorites) 
that are delivered with the product. Click the Next button. 

 

The next step is also the last one. There is generally no need to run this wizard again: you will be able to 
directly modify in PROMODAG Reports the options you selected in the configuration wizard.  

For more information about these options, please refer to our Online help. 
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At this point, PROMODAG Reports has enough information to start the import process. 

 Processing imports and reports 
Clicking the Finish button starts importing data. The complete process includes all previously configured 
steps, and can take some time depending on your selections. 

Note: Import options may be saved in a batch file, so that the import process can be automated and 
scheduled at your convenience. See "Automating and scheduling the collection of data and other actions 
", on page 37.. 

  

 PROMODAG Reports  

1. Imports the directory,  
2. Imports message tracking files, 
3. Imports storage size, 
4. Imports IIS files, 
5. Runs selected reports. 

Each operation finishes off by displaying an operation report dialog box. A trace file is also recorded and 
can be used to troubleshoot possible errors or resolve various configuration issues. If you need to do so, 
use the Tools > Consult Trace Files option to view the content of the last trace files. 

 

 

E - Running your first report 
To illustrate the configuration method of a report, we are now going to run a sample report and try to 
address the following question: Who sent the most messages to Internet last week? 

Our detailed requirements are to analyze last week's email Internet traffic for all mailboxes in our 
organization, and to get a report showing the top 5 senders, by number of sent messages, by department 
in our company. 
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1. Setting up the report: 
Activity level of a group of mailboxes in a given period can be analyzed with to the Mailbox by Traffic 
Level report.  This report uses message tracking files imported into the database as data source. 

Under the Reports menu, select Mailbox Traffic and then Mailbox by Traffic Level to open the report 
dialog box.  

This dialog box includes a variety of tabs. Many of them are common to all reports. We are going to 
review them one by one and configure them in order to obtain the report that meets our requirements. 

Period tab: 
The Period tab allows selecting a specific reporting period. It is possible to select an absolute or relative 
date range as well as particular days. You can even focus on business hours. 

We want to analyze last week's email traffic. 

• Activate the Relative radio button and select 1 previous week(s) as reporting period. PROMODAG 
Reports automatically displays the corresponding dates in the From and To fields below.  

Note: Make sure that message tracking files covering this date range have been imported.  

 

Selection tab: 
The Selection tab allows selecting the group of directory objects (mailboxes, servers...) on which 
PROMODAG Reports is going to report. For example, mailbox type objects can be selected according to 
various Active Directory attributes such as Company, Department or Active Directory Container. 

We are going to analyze the whole of our Exchange organization's mailbox traffic. 

• Activate the All organization mailboxes radio button.  
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Correspondents tab: 
The Correspondents tab allows filtering the analyzed traffic by  address types, such as Administrative 
group (internal traffic) or Internet domain (external traffic). 

We are interested, in this particular case, in displaying outbound message traffic (to Internet). 

• Activate the Some types radio button, then limit the address types to Internet messages only by 
selecting Internet domain like * in the selection grid.  

 

Group tab: 
The Group tab allows grouping the report results at one or more levels of your choice. For instance, you 
may want to group the results of your report by Company at level 1, and by Department at level 2. 

We have decided to group our organization's mailboxes by department. Moreover, we want to obtain a 
sub-total by department of the number and volume of sent and received messages. 

• Select Department and select the Total check box.  



  Getting started with PROMODAG Reports  31 

 

Options tab: 
The Options tab allows selecting various sorting options of the report results. 

We have chosen to only display the top 5 email senders of each department and we would also like to 
sort results by number of sent messages. 

 Tabular data settings section: 
• Select the Show only check box, enter the number of mailboxes to display in the below field (5) 

and select the Biggest and From group  radio buttons. 
• Then select the Number and Sent radio buttons. 

Note: Selecting the From group option allows the report to display the top 5 senders for each 
department, while the From selection option would retrieve the top 5 senders for all organization 
mailboxes. 

Sort by option: 

The list can be sorted in ascending or descending order. We want to sort results by number and by 
descending order.  

• Select the Number, Sent and Descending radio buttons. 

Count a multiple sending as section : 
A message sent to n recipients is counted as 1 sent message or n sent messages. You can only select 
one of these two options. 

We want to count each message as 1. 

• Select the 1 message radio button. 
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Content tab: 
The Content tab allows selecting the detail level of the final report, and the direction of the traffic (Sent, 
Received). 

 

Option Description 

Correspondents' 
address type 

Check this box to display the address type in the report, e.g. Exchange or 
Internet. 

Optional mailbox 
attribute 

Select one directory attribute related to mailboxes, such as their SMTP address 
(Email address), to display in the report. 

Messages Choose the direction of traffic to display in the report: sent messages, received 
messages, and/or total. 

Mailboxes with no 
traffic 

Check this box to display all selected mailboxes including those with no traffic 
during the chosen period. 

Anonymous report For confidentiality reasons, you may select this check box to replace mailbox 
names by an anonymous label followed by a counter (Mailbox 1, Mailbox 2 etc.). 

We only want to display sent messages. 

• Select the Sent check box. 
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Output tab: 
The Output tab allows choosing the output destination of the final report. 

Reports can be displayed on screen or exported under various formats. 

We wish to output this report to screen. 

• Select Screen in the Destination drop-down list. 

 

Note: Should you need to automate a report by including it in a batch file, you will have to select another 
destination than Screenin the Output tab, e.g. Disk file or Email recipient. Screen output is not 
available for automated reports. 

2. Generating the report: 
Once all report options have been set, click the OK button to generate the report. PROMODAG Reports 
retrieves the information it needs in the database and queries it to produce the requested report. The 
report appears in a preview window.  
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This report displays the top 5 senders to Internet by department sorted by number of messages sent. It 
can happen that this top 5 includes more than 5 mailboxes (when the number of sent messages is 
identical for two - or more - mailboxes: for example, VAN DEN BRANDEN Marie-Jeanne and BETZNER 
Pamela from the Architecture Department both sent 18 messages. Therefore, their mailboxes are only 
counted once). 

 

This previewed report can be printed or reloaded (  or  buttons), but also exported or saved for later 
use. 

3. Exporting the report 
Click the  button to export the report (or use the File > Export Report option). 

Reports may be exported under various destinations (disk file, email recipient, Exchange folder or 
SharePoint), and under different formats (RPT, CSV, XLS, HTM, PDF, RTF or MHT).  
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For more information about file destinations and formats, please refer to our Online help. 

4. Saving the report 
Click the  button to save your report options in a file, or to save a 'snapshot' of your report.  

Save Report Options 
Select Save Report Options to save your options in a file. 

A PROMODAG Report Options file is a text file containing options for a report. Report options files 
contain a whole set of options for a given report, e.g. date, server, sorting order... The report option file 
extension is *.pro. 

This file can be  

• reused in a batch file - provided the destination selected in the Output tab is not Screen - if you 
should need to automate and schedule report generation (for more information, please refer to 
"Automating and scheduling the generation of reports", on page 41.), 

• or saved in the Favorites menu. 

The Favorites menu 
This menu lists pre-configured reports options files (or favorites) delivered with the product. 

These preset reports are organized in five categories: 

• Administrative information, 
• Content analysis, 
• Traffic from and to Internet analysis, 
• Traffic overview, 
• User activity analysis. 

Each of these favorites answers a question, for example: How many messages were sent to Internet last 
week? in the Traffic from and to Internet analysis group. 

You can add new entries to this menu yourself by selecting the Add to Favorites menu option when 
saving your report options files, or even add your own categories by creating new sub-folders into the 
\Batches folder.  

In this last case, we recommend that you give it a meaningful name such as Top senders to Internet. This 
will make it easier to locate the report options file in the Favorites menu. 

 

To find some examples of common reports settings, please refer to "Our customers top 10 favorite 
reports ", on page 46.. 

Save Report Snapshot 
Select Save Report Snapshotto save a still image of the active report as a *.RPT file. It will be viewable 
using the My Snapshots menu. 
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This option may be handy if you need to quickly save your report 'as is', and then export it later on. For 
example, you can save your report as a snapshot, export it today as a *.CSV file, and decide next week 
that you will also export it as a *.PDF file attached to an email that will be sent to a dozen recipients (there 
is no need to use an email client: simply select the Email recipient destination). 



  

  

Chapter 3 - Automating and scheduling tasks 

A - Introducing batch files and report options files 

1. What is a batch file? 
A batch file is a text file containing one or more commands: report generation, data import or other 
action. Batch files are useful if you need to import data out of business hours, or to generate and publish 
pre-defined reports automatically. By default, batch files are saved under the 
%ALLUSERSPROFILE%\Application Data\Promodag\Reports\8\Batches\ directory (or 
%PROGRAMDATA%\Promodag\Reports\8\Batches\ if you use Windows Vista, 2008 Server or 7) with 
a PRB extension. 

2. What is a report options file? 
A PROMODAG Report Options file is a text file containing options for a report. Report options files 
contain a whole set of options for a given report, e.g. date, server, sorting order... The report option file 
extension is *.pro. 

B - Automating and scheduling the collection of data and 
other actions   
PROMODAG Reports can be configured to import message tracking files and, for instance, delete old 
data by following these steps: 

1. Create a batch file and select what should be imported.  
2. Add actions to the batch file. 
3. Schedule the batch file using Windows Scheduler.  
4. Run the batch file. 

In the following example, we are going to create and schedule a batch file to automate message tracking 
files import, and delete data older than 90 days. 

1. Creating a batch file  
Use the Tools > Task Automation menu to access the automation screen. Click the New batch button, 
enter a file name and a description.  
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Exploring available actions  
Click and expand available actions in the Actions section of the Actions and Reports tree: 

 

Action Description 

Database Specification Select a specific database to be 
used when the batch job runs.  

Batch Trace File Location Select a location where trace files 
will be generated. 

Create HTML TOC Create an HTML file including a TOC 
(Table of Content) with links to 
exported reports included in the 
batch. 

Directory Connection Choose a specific directory 
connection to be used when the 
batch job runs. 

Exchange Connection Choose a specific Exchange 
connection to be used when the 
batch job runs. 

Purge Data Imports Purge old messages from the 
database. 

 Import Directory Import or update the directory. 

 Import Message Tracking Files  
Import message tracking files. 

 Import Internet Information 
Services 

Import Internet Information 
Services log files. 

 Import Storage Size Import information store size. 

Import IMC Archives Import Internet mail connector 
archives (when applicable). 

Compact database Compact or shrink the database to 
reclaim unused disk space. 

2. Adding actions to the batch file   
• Select Import Message Tracking Files in the Actions tree, then click the  button. The default 

settings will import messages tracking files for the selected servers from the last import date up to 
yesterday.  

• Click  OK to save your changes.  
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You may decide that you only need three months of message tracking files in your database. 
PROMODAG Reports is able to clear automatically obsolete data.  

• Select Purge Data Imports in the Actions tree, then click the  button.  
• Select the server name to specify from which server(s) data must be cleared, and click the  

button to move it to the right pane (you can also double-click the server name). Data will then be 
deleted from all servers listed in the Selected server(s) pane. 

• Select the period to clear, and the type of data to remove. In this example, we chose to delete 
message tracking files and Internet Information Services files imported before the last 90 days.  

• Click OK to save your changes. 
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3. Scheduling the batch file  
Use the Tools > Task Automation menu to access the automation screen.In the Batch file name drop-
down list, select the batch file to schedule.In this example, we want to schedule PeriodicImport.prb. 

 

Note: By default, actions will be carried out on the last database opened, unless you specify which 
database must be used (action: Database specification).  

•  Click theSchedule button. 
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• Check that the account in the Run as field is the same as the one you use for PROMODAG 
Reports in interactive mode.  

• Use theSet passwordbutton.  
• Select theSchedule tab and create a new scheduled task.  

Note: For more details on this dialog box, see the Microsoft Windows Help system. 

4. Running the batch file 
 The Windows Task Scheduler starts PROMODAG Reports  and it processes actions included in the 
batch file. From now on, imports will be automatically carried out at the scheduled time. 

PROMODAG Reports generates a trace file that contains information on what happened while the batch 
was running. Trace files can be automatically emailed.  

• It is recommended that data related to particularly large files (i.e. message tracking files and IIS 
logs) is imported on a daily basis. The process is shorter and easier to monitor.  

• Exchange message tracking files being closed at midnight GMT, import batch jobs should be 
scheduled from 1AM (GMT) onwards. 

• It is recommended to create one single batch for clearing imports and importing data (otherwise 
the Clear Import job may still be in progress when the data import job is scheduled to start, and 
therefore the latter will fail). 

C - Automating and scheduling the generation of reports 
PROMODAG Reports can be configured to generate reports automatically by following these steps: 

1. Create one or more report options file(s). 
2. Create a batch file and add one or more of these report option file(s). 
3. Schedule the batch file using the Windows Scheduler. 
4. Run the batch file. 

In the following example, we are going to create and schedule a batch file to automate the Mailbox by 
Traffic Level report we have learned to set up earlier (see "Running your first report", on page 28.). 

1. Creating a report options file 
See the "Save Report" section above to review the method of creating report options files. 
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Note: Should you need to automate a report by including it in a batch file, you will have to select another 
destination than Screenin the Output tab, e.g. Disk file or Email recipient. Screen output is not 
available for automated reports. 

2. Creating a batch file  
Use the Tools > Task Automation menu to access the Task Automation screen. Click the New batch 
button, enter a file name and a description. 

 

Exploring available reports 
The left pane of theTask Automation window lists all actions and reports that can be automated.  

Locate the Mailbox by Traffic Level report in the  Actions and Reports list.  

Reports are classified in the same order as in the Reports menu. Therefore, you will find Mailbox by 
Traffic Level in the Mailbox Traffic folder. 

Adding the Mailbox by Traffic Level report 

Select the report options file entitled Top Internet senders and click the  button to insert it into the 
right pane (Batch file content). 
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3. Scheduling the batch file 
Use the Tools > Task Automation menu to access the automation screen. In the Batch file name list box, 
select the batch file to schedule. In this example, we want to schedule DailyReports.prb.  

 

Click the Schedule button. 
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Check that the account in the Run as box is the same as the one you use for PROMODAG Reports in 
interactive mode. Use the Set password functionality. Select the Schedule tab and create a new 
scheduled task. 

 

Note: For more details on this dialog box, see the Microsoft Windows Help system. 

4.  Running the batch file 
 The Windows Task Scheduler starts PROMODAG Reports  and it runs reports included in the batch file. 
From now on, reports will be automatically generated at the scheduled time.   
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PROMODAG Reports generates a trace file that contains information on what happened while the batch 
was running. Trace files can be automatically emailed.  
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Our customers top 10 favorite reports  

The following pages describe in detail the settings of the ten reports that PROMODAG Reports users 
have requested the most so far. 

Each table include an usage description of the report option file, its corresponding entry in the Favorites 
menu, its corresponding report template in the Reports menu, and eventually a tab-by-tab list of options 
to apply. 

For more information on favorites, please refer to Saving report options. 

1 - What is the mailbox breakdown by size?  
 

Description:  What is the breakdown of the Exchange organization mailboxes by size? 

Favorite:  Content analysis > What is the mailbox breakdown by size? [dynamic] 

Report template: Storage > Mailbox Breakdown by Size 

Options used: 

• Selection tab: All organization mailboxes 
• Group tab: Level 1: No grouping 
• Intervals tab: Define intervals: Size, Less than: 100KB, 1MB, 5MB, 10MB, 50MB, 100MB 
• Presentation tab: Display: 3D graph; Size in KB: KiloBytes 
• Output tab: Destination: Screen 

  

2 - Do our users empty their Deleted Items folder? [dynamic] 
 

Description:  Do users of our Exchange organization empty their Deleted items folder ? 

Favorite:  Content analysis > Do our users empty their Deleted Items folder? [dynamic] 

Report template: Mailbox Information > Mailbox Folder Size 

Options used: 

• Selection tab: All organization mailboxes 
• Group tab: Level 1: No grouping; Total 
• Filter tab: Some criteria: Deleted items > 0 item 
• Content tab: Detail level: Mailbox 
• Presentation tab: Size in KB: KiloBytes 
• Output tab: Destination: Screen 
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3 - What are the 10 biggest mailboxes in our organization? 
 

Description:  What are the top 10 largest mailboxes of the Exchange organization today? 

Favorite:  Content analysis > What are the 10 biggest mailboxes in our organization? 

Report template: Storage > Mailbox Storage Information 

Options used: 

• Selection tab: All organization mailboxes 
• Group tab: Level 1: No grouping; Grand total 
• Filter tab: not used 
• Options tab: Graph data selection: 10, Biggest, From selection, By: Size; Tabular data selection: 

Show only, 10, Biggest, From selection, By: Size; Sort by, Size, Descending 
• Content tab: Detail level: Mailbox storage (item size and count) 
• Presentation tab: Display: Graph & Table; 3D graph; Size in KB: KiloBytes 
• Output tab: Destination: Screen 

  

4 - What is the mailbox item breakdown by age? 
 

Description:  What is the current mailboxes items distribution by age? 

Favorite:  Content analysis > What is the mailbox items breakdown by age? 

Report template: Mailbox Information > Item Breakdown by Age 

Options used: 

• Selection tab: All organization mailboxes 
• Group tab: Level 1: No grouping 
• Folders tab: Select folders, Inbox, Include 
• Filter tab: All item types 
• Intervals tab: Less than: 1 Day(s), 1 Week(s), 1 Month(s), 1 Quarter(s), 1 Semester(s), 1 Year(s) 
• Content tab: Not used 
• Presentation tab: Display: 3D graph; Size in KB: KiloBytes 
• Output tab: Destination: Screen 
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5 - What are the 10 mailboxes that have grown the most in the last 
week? 
 

Description:  What are the top 10 mailboxes that have grown the most in the last week? 

Favorite:  Content analysis > What are the 10 mailboxes that have grown the most in the last 
week? 

Report template: Storage > Mailbox Size Fluctuation 

Options used: 

• Period tab: Relative, 1 previous week(s) 
• Selection tab: All organization mailboxes 
• Group tab: Level 1: No grouping 
• Filter tab: Increase, By percentage >= 10% 
• Options tab: Tabular data selection: Show only, 10, Biggest, From selection, By: Size, % Increase; 

Sort by: Size, % Increase, Descending 
• Presentation tab: Size in KB: KiloBytes 
• Output tab: Destination: Screen 

  

6 - What are the top 10 sending SMTP domains by messages 
quantity? 
 

Description:  What have been the top 10 sending Internet domains to our Exchange organization 
by message quantity this month? 

Favorite:  Traffic from and to Internet analysis > What are the top 10 sending SMTP domains 
by messages quantity? 

Report template: Server Traffic > Correspondents by Traffic Level 

Options used: 

• Period tab: Relative, current month 
• Selection tab: All organization servers 
• Group tab: Level 1: No grouping 
• Correspondents tab: Some types: Internet domain Like * 
• Recipient type tab: All recipient types 
• Options tab: Graph data selection: 10, Biggest, From selection, By: Number, Received; Tabular 

data selection: Show only, 10, Biggest, From selection, By: Number, Received; Sort by: Number, 
Received, Descending 

• Presentation tab: Display: Graph & Table; Size in KB: KiloBytes 
• Output tab: Destination: Screen 
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7 - How does our internal traffic compare to our traffic with Internet 
recipients? 
 

Description:  What have been the respective parts of internal traffic (with Exchange) and external 
traffic (with Internet) this month? 

Favorite:  Traffic overview > How does our internal traffic compare to our traffic with Internet 
recipients? 

Report 
template: 

Server Traffic > Server Traffic Comparison by Type 

Options used: 

• Period tab: Relative, current month 
• Selection tab: All organization servers 
• Group tab: Level 1: No grouping 
• Correspondents tab: Some types: Administrative group Like *, Internet domain Like * 
• Recipient type tab: All recipient types 
• Options tab: 1 message 
• Content tab: Detail level: Correspondents' address type 
• Presentation tab: Display 3D graph; Size in KB: KiloBytes 
• Output tab: Destination: Screen 

  

8 -  What has been the evolution of our mailbox traffic since last 
week? 
 

Description:  How has mailbox traffic evolved in size and number of messages since last week? 

Favorite:  Traffic overview > What has been the evolution of my mailbox traffic since last week? 

Report template: Mailbox Traffic > Mailbox Traffic Growth 

Options used: 

• Period tab: Relative, 7 previous days; Time interval: day(s) 
• Selection tab: All organization mailboxes 
• Group tab: Level 1: No grouping 
• Correspondents tab: All address types 
• Options tab: Count a multiple sending as, 1 message 
• Content tab: Messages: Sent, Received 
• Presentation tab: Size in KB: KiloBytes 
• Output tab: Destination: Screen 
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9 - What is the evolution of our server traffic since last week? 
 

Description:  How has server traffic evolved in size and number of messages for the last 7 days? 

Favorite:  Traffic overview > What has been the growth of our server traffic since last week? 

Report template: Server Traffic > Server Traffic Growth 

Options used: 

• Period tab: Relative, 7 previous day(s); Time intervals: day(s) 
• Selection tab: All organization servers 
• Group tab: Level 1: No grouping 
• Correspondents tab: All address types 
• Recipient type tab: All recipient types 
• Options tab: Count a multiple sending as: 1 message 
• Content tab: Detail level: Total 
• Presentation tab: Display: 3D graph; Size in KB: KiloBytes 
• Output tab: Destination: Screen 

  

10 - Who are the top 10 email senders of the Exchange organization? 
 

Description:  Who are the current top 10 email senders of the Exchange organization? 

Favorite:  Traffic overview > Who are the top 10 email senders of the Exchange 
organization? 

Report template: Mailbox Traffic > Mailbox by Traffic Level 

Options used: 

• Period tab: Relative, 1 previous week(s) 
• Selection tab: All organization mailboxes 
• Group tab: Level 1: No grouping; Total 
• Correspondents tab: All address types 
• Filter tab: Not used 
• Options tab: Tabular data selection: Show only, 10, Biggest, From selection, By: Number, Sent; 

Sort by: Number,Sent, Descending; Count a multiple sending as, 1 message 
• Content tab: Messages: Sent 
• Presentation tab: Size in KB: KiloBytes 
• Output tab: Destination: Screen 
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List of reports 

The 80 report templates included in PROMODAG Reports version 8 can be sorted by groups that can 
themselves be split into five main reports categories:   

• Reports on Exchange-related directory objects (Inventory group of the Reports menu).  
• Reports on flow and traffic (Connector Flow, Mailbox Traffic, Server Traffic, Public Folders 

Traffic, Traffic Optimization and Traffic Statistics groups of the Reports menu as well as some 
reports of the Billing group). 

• Reports on messaging activity (ActiveSync Activity and OWA Activity groups of the Reports 
menu). 

• Reports on storage (Storage group of the Reports menu as well as some reports of the Billing 
group). 

• Reports on content and size (Mailbox Information and Public Folders Information groups of 
the Reports menu). 

5. ActiveSync Activity 
Find out who is using ActiveSync and when. 

ActiveSync User Breakdown by Hour of 
the Day  

This graphical report displays a histogram showing the 
average number of distinct ActiveSync users for each hour of 
the day during a given period.  

ActiveSync Request List  This report shows a list of ActiveSync requests (hits) during a 
given period. Several detail levels are available.  

ActiveSync Usage Growth   This graphical report displays a histogram showing the daily 
number of distinct ActiveSync users during a given period.  

ActiveSync User Breakdown by Day of the 
Week  

This graphical report displays a histogram showing the 
average number of distinct ActiveSync users for each day of 
the week during a given period.  

6. Billing 
Allow chargeback based on mailbox storage size or message traffic. 

Cost Allocation  This report allows you to allocate a billed amount, either in 
percentage or in absolute value, to up to four cost center 
categories: number of mailboxes, number of sent messages, 
number of received messages, storage size used. Selected 
mailboxes may then be grouped by attribute so that each 
group is billed on a pro rata basis.  

Mailbox Storage Cost Chargeback  This report calculates a storage size cost for selected 
mailboxes.  

Mailbox Traffic Cost Chargeback  This report calculates traffic costs for selected mailboxes.  
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7. Connector Flow 
Get information on inbound or outbound messages going through connectors. 

Connector Flow by Type  This report shows the number and volume of outgoing and 
incoming messages for the selected connectors. Some 
specific recipient types can be selected.  

Connector Flow Growth   This graphical report displays a line chart or a histogram 
showing connector flow growth during a time frame. Some 
specific recipient types can be selected.  

Flow Origin and Destination  This report shows the connectors flow detail according to 
messages origin and destination.  

Flow Between Servers  This report displays the number and volume of of outgoing 
and incoming messages for the selected connectors by 
recipient type.  

Transiting Flow  This report displays the flow of messages transiting through 
the selected servers but not intended to them.  

8. Inventory 
List directory objects information. 

Directory Objects  This report lists directory objects in a hierarchical 
presentation.  

Distribution Groups  This report lists Exchange distribution groups and their 
members.  

Number of Recipients Grouped by 
Attributes  

This report counts mailboxes based on specific mailbox 
directory attributes.  

Recipient Detail  This report displays directory attributes of each selected 
recipient.  

Recipients per SMTP Domain  This report lists, counts and groups recipients based on the 
SMTP domain they belong to.  

Selected Attributes from Mailboxes  This report allows choosing specific attributes related to the 
selected mailboxes. Directory, traffic and storage attributes 
are available for each mailbox.  

 



  Getting started with PROMODAG Reports  53 

9. Internal Message Delivery 
Measure your service level agreement by calculating internal message delivery time. 

Message Breakdown by Delivery Time  This graphical report displays a histogram of transmission time 
broken down into duration intervals between two Exchange servers 
during a given period.  

Message Delivery Detail  This report displays a fully detailed list of messages exchanged 
within the Exchange organization during a given period and grouped 
by time delivery. The information provided includes MessageID.  

Message Delivery Status  This graphical report produces two histograms showing delivered 
and non-delivered messages in numbers and in percentage.  

10. Mailbox Content 
Search what users are storing in their mailbox, e.g. attachments. 

Access Permissions to Mailbox Folders  This report generates a list of permissions granted on the 
selected mailboxes folder.  

Mailbox Folder Size  This report displays the size and count of items contained 
into the selected mailbox folders at different detail levels.  

Appointment Search  This report produces, from a selection on mailboxes, a 
detailed list of appointments created in Microsoft Outlook.  

E-mail Rules  This report extracts a list of all message rules defined for 
selected mailboxes.  

Folder Size Comparison  This graphical report displays a histogram of the number and 
size of items contained in a selection of mailboxes folders.  

Item Breakdown by Age  This graphical report displays a histogram of items contained 
in selected mailboxes and broken down by age.  

Item Breakdown by Size  This graphical report displays a histogram of items contained 
in selected mailboxes and broken down by size.  

General Mailbox Content  This report displays items contained in selected mailboxes. 
NB: Empty folders are not listed.  

Mailbox Content Summary  This report displays a synthetic overview of items contained 
in selected mailboxes and broken down by age. NB: Empty 
folders are also listed.  

Mailbox Specific Content Estimation  This report displays the size of specific folders and/or items 
based on user’s choice within the selected mailboxes beside 
their total size. It also shows the mailboxes global storage 
limit, and an alternative storage limit defined in relation to 
those specific folders and/or items.  

Message Attachments  This report searches for attachments in selected mailboxes.  

Performed Actions on Messages  This report displays the number of messages contained in 
selected mailboxes, and distributes this total between 4 types 
of actions: reply, forward, without action, not read.  
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11. Mailbox Traffic 
View in detail with whom your users are corresponding, and the kind of messages they exchange. 

Inter Group Traffic  This graphical report displays a 3-D column chart on traffic 
between groups of mailboxes.  

Internet Traffic Detail (Exchange 5.5)  This report shows, for each user, sent and received 
messages to and from Internet. Recipient name, message 
subject and an attachment list are displayed for each 
message.  

Chronological Traffic Activity  This report produces a raw list of messages sent to and 
received from the selected mailboxes for a given period in 
chronological order  

Daily Traffic Summary  This report shows the number and size of sent and received 
messages for each mailbox included in the selection on a 
daily basis. It only takes two types of traffic into account: 
with the Exchange organization; with Internet. The General 
Mailbox Traffic report can give you a more complete figure if 
necessary.  

Find Specific Messages  This report searches for messages received or sent by the 
population defined in the Selection tab according to one or 
more specific filters. It is recommended to use restrictive 
criteria.  

General Mailbox Traffic  This report displays the number and volume of messages 
sent and/or received by selected mailboxes during a given 
period.  

Mailbox Traffic Across Time Interval  This report shows the volume and number of sent and/or 
received messages by selected mailboxes across different 
time intervals during the selected period.  

Mailbox by Traffic Level  This report shows the activity level of selected mailboxes 
during a given period.  

Mailbox Traffic Comparison  This report sorts and compares traffic of sent and received 
messages for mailboxes or groups of mailboxes.  

Mailbox Traffic Growth   This report displays a chart of mailbox traffic growth across 
different time intervals during the selected period.  

Traffic Between Recipients  This report shows the number and detail of sent and received 
messages for each selected mailbox, and the corresponding 
recipients.  
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12. OWA Activity 
Find out who is using web mail and when. 

OWA User Breakdown by Hour of the Day  This graphical report displays a histogram showing the 
average number of distinct OWA users for each hour of the 
day during a given period.  

OWA Request List  This report shows a list of OWA requests (hits) during a given 
period. Several detail levels are available.  

OWA Usage Growth   This graphical report displays a histogram showing the daily 
number of distinct OWA users during a given period.  

OWA User Breakdown by Day of the 
Week  

This graphical report displays a histogram showing the 
average number of distinct OWA users for each day of the 
week during a given period.  

13. Public Folder Content 
Get a clear picture of who uses public folders, when and for what purpose. 

Access Permissions to Public Folders  This report generates a list of permissions granted on the 
selected public folders.  

Public Folder Size  This report generates a list of sub-folders and items stored in 
the selected public folders, and calculates their size.  

General Public Folder Content  This report displays items contained in selected public 
folders.  

14. Public Folder Traffic 
View public folders traffic individually or grouped. 

General Public Folder Traffic  This report displays the number and volume of messages 
sent and/or received by selected public folders during a given 
period.  

15. Server Traffic 
Display the type of traffic processed by servers. 

Correspondents by Traffic Level  This report displays the number and volume of sent and 
received messages by domain or administrative group for a 
given period.  

Server Traffic by Recipient Type  This report shows the number and volume of sent and 
received messages for the selected servers. Some specific 
recipient types can be selected.  

Server Traffic Comparison by Type  This graphical report displays 4 pie charts showing the 
number and volume of sent and received messages by 
address type for the selected servers on a given period. 
Some specific recipient types can be selected.  

Server Traffic Growth   This graphical report displays a line chart or a histogram 
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showing server traffic growth during a time frame. Some 
specific address and recipient types can be selected.  

Traffic Between Servers  This report displays the number and volume of sent and 
received messages for the selected servers, by recipient type.  

16. Storage 
Show how your storage capacity is used and how it changes over time. 

Information Store Size Comparison  This graphical report displays a histogram of the selected 
information stores size for each imported date in a given 
period, A different page is displayed for each imported date.  

Information Store Size Growth   This graphical report displays a histogram of the selected 
information stores size growth during a given period.  

Mailbox Storage Information  This report provides detailed information, such as mailbox 
storage quotas and message size limits, storage size and 
item count, on the selected mailboxes.  

Mailbox Breakdown by Size  This graphical report displays a histogram of selected 
mailboxes broken down into intervals, either by size or by 
number of items.  

Mailbox Size Growth   This graphical report displays two histograms of the selected 
mailboxes growth based on number and size of items during 
a given period.  

Mailbox Size Fluctuation  This report calculates the selected mailboxes size fluctuation 
in number of items or size during a given period.  

Public Folder Storage Information  This report provides detailed storage information on selected 
public folders.  

17. Traffic Optimization 
How to optimize traffic. 

Mail Storage Optimization  This report displays each received message, shows how 
many times it was received, and the home servers of the 
recipients' mailboxes.  

Non-Delivery Reports  This report lists Non-Delivery Reports messages (NDR).  

SMTP Address Usage  This report searches for messages whose sender or recipient 
address fields contain a particular email address or domain 
name.  

IMF Events List  This report lists messages marked by Exchange Intelligent 
Message Filter (IMF) as spam.  

SMTP Servers By Traffic Level  This graphical report displays the number and volume of 
received messages by SMTP server for a given period. These 
servers may be external machines, or belong to the 
Exchange organization.  
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18. Traffic Statistics 
Get graphs showing traffic breakdown by days, hours, size of messages or number of recipients. 

 

Mail Contact Usage  This report shows the number and volume of messages sent 
to contacts during a selected period.  

Message Breakdown by Day of the Week  This graphical report displays a histogram of the average 
number and volume of messages per day of the week during 
a given period.  

Message Breakdown by Hour of the Day  This graphical report displays a histogram of the average 
number and volume of messages per hour of the day during 
a given period.  

Distribution Group Usage  This report shows the number and volume of messages sent 
by internal users to distribution groups during a selected 
period.  

Mailbox Breakdown by Daily Traffic  This graphical report displays a histogram of selected 
mailboxes broken down into intervals based on the average 
number or size of messages they send or receive during a 
given period.  

Message Breakdown by Recipient Count   This graphical report displays a histogram of messages sent 
or received by selected mailboxes, broken down by number 
of recipients, during a given period.  

Message Breakdown by Size  This graphical report displays a histogram of messages sent 
or received by selected mailboxes, broken down by size, 
during a given period.  
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Support 

Your support options include:   

Self-help resources  
Please browse the following self-help resources before placing a support request, as they may indeed 
contain the solution to your problem and save your time:  

1. This Quick Start Guide: it will give you the basic information needed to install, configure and start 
using the product.  

2. The Online help (http://www.promodag.com/support/OnlineHelp/Repex.htm) will give you a more 
detailed information on PROMODAG Reports, from licensing to troubleshooting.  

3. The Knowledge Base (http://www.promodag.com/Portal/KB/root.aspx): it contains answers to 
common questions.  

Email and over-the-phone software support  
If you still have not found an answer to your question, you may submit a request to our Customer Support 
team under the following conditions:  

• You are evaluating the product: Support for PROMODAG Reports is free of charge during the 
45-day trial period. However, you can submit up to 2 tickets via email at support@promodag.com 
(or use the Help > Technical Support Request option in the product).  

• You are an existing customer and your maintenance plan is currently valid: There is no limit 
to the number of technical support requests you can submit, either  

a. via email at support@promodag.com (or use the Help > Technical Support Request 
option in the product), or 

b.  by phone: +33 1 53 27 66 60 or Toll Free (from USA only): 1(888) 696-5404.  
• You are an existing customer and your maintenance plan is no longer valid: You cannot 

submit any technical support request. However, you can subscribe at any time, just request a 
quotation from our sales department with your license number.  

Note: We normally respond within 2 hours, but please allow 24 hours for us to respond to account for 
possible differences in international time zones. Our office hours are 9 AM to 6 PM GMT+1 (Paris), 
Monday to Friday.  

http://www.promodag.com/downloads/documentation/quickstartV8_en.pdf
http://www.promodag.com/support/OnlineHelp/Repex.htm
http://www.promodag.com/Portal/KB/root.aspx
mailto:support@promodag.com?subject=Support%20request%20for%20PROMODAG%20Reports
mailto:support@promodag.com?subject=Support%20request%20for%20PROMODAG%20Reports
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